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SedonaOffice Training Guide

This training guide can be used to supplement self-training in SedonaOffice. It covers basic functions in SedonaOffice and is not intended for use as an in-depth software manual. This document was written by and is the property of Astute Financial Consulting, LLC. Please do not copy or redistribute outside of your organization without written permission from Astute.
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[bookmark: _Toc53932543]The Toolbar
The toolbar allows you to perform actions such as opening and closing your companies, printing, and customer lookup.
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Close a company
1. Click File.
2. Click Close Company.
3. Select the database you would like to close.
4. Click OK.
Open a company
1. Click File.
2. Click Open Company.
3. Select the database you would like to open from the drop-down list.
4. Click Select.
Find a customer
[image: ]Option 1: The Client Management module 
1. Expand the Client Management module.
2. Click Customer Explorer.
3. Select the criteria on which you would like to search.
a. Search on multiple criteria by switching between Advanced View and Simple View.
b. To add additional criteria in Advanced View, click Add Criteria.
c. To reset, click Clear Criteria.
4. Enter text in the search field.
5. Click Search.
6. Double-click the customer to open, or highlight and click Select.
Option 2: The drop-down list 
1. Enter a customer name or number in the drop-down list in the toolbar.
2. Hit enter on your keyboard or click the binoculars icon.
3. You may also open the drop-down list and select from recently accessed accounts.
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Option 3: The binoculars icon
1. Click on the binoculars icon next to the drop-down list.
2. Select the criteria on which you would like to search.
a. Search on multiple criteria by switching between Advanced View and Simple View.
b. To add additional criteria in Advanced View, click Add Criteria.
c. To reset, click Clear Criteria.
3. Enter text in the search field.
4. Click Search.
5. Double-click the customer to open, or highlight and click Select.
6. Highlight and double-click the appropriate customer, or highlight and click Select.
Print a document
1. Open a document or a record, such as an invoice.
2. Click on the print preview icon in the toolbar or File > Print Preview.
3. You may choose to save the document to the server in one of several formats, including PDF or Excel.
4. Click Print & Close or File > Print.
Delete a record
1. Open an item such as an invoice or purchase order.
a. Note that the record must not have any transactions, open or closed, against it or you will be unable to delete it.
2. Click on the red delete icon in the toolbar.
3. When asked if you want to delete the record, click Yes.
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The company explorer is comprised of the various modules in SedonaOffice. Each module has several functions associated with it. An individual user’s view of the modules in this area will differ depending on the permissions given to that user.
Client Management
This module allows you to perform cancellations, collections, company rate changes, customer lookup, and customer queries. You can also manage EFT customers, chain accounts and master accounts, and create new customers.
Accounts Receivable
This module allows you to perform cycle invoicing, process finance charges, make deposits, process payments, print and email invoices, and create statements. You can create invoices and credit memos directly through this module as well as view a list of customers with unapplied cash or credit.
General Ledger
In this module, you are able to maintain your chart of accounts, manage accounting periods, create and view journal entries, view your account register, reconcile bank accounts, and manage royalties and commissions. You can work with the GL query builder from this module.
Accounts Payable
The Accounts Payable module is where you access vendors and vendor bill information, as well as create and pay bills. You may also write and print checks here, create and receive purchase orders, manage AP recurring items, and view your suggested purchase order list. You can work with the AP query builder from this module.
Inventory
In this module, you can issue parts, process returns, manage manufacturers and warehouses, complete transfers between warehouses, add parts to SedonaOffice, and create repair orders. This is also the module in which you will manage physical inventory counts and adjustments. You can also work with the part query builder from this module.
Job Management
This module allows you to track and invoice all jobs (open or closed), view and schedule appointments, and manage timesheets. This module is an integral part of job processing. You can work with the job query builder from this module. This module will integrate with the QuoteWerks or Wesuite add-on softwares.
Payroll
The Payroll module will help you keep track of employee timesheets. This module is used in conjunction with your current payroll software/company.
Sales Management
The Sales Management module is a useful tool for organizing and managing your opportunities (potential jobs) and prospects (potential customers). This module also allows you to convert a prospect into a customer. This module will integrate with the QuoteWerks add-on software. 
Service
In this module, you will manage all tasks related to service calls, including ticket creation, scheduling, and invoicing. You will also manage all inspections through the Service module. This module will integrate with FSUWeb or Fleetmatics add-on softwares.
General Documents
General Documents is a storage area used to keep documents not related to a specific record (e.g., jobs/service, customer, vendor). It is only available with SedonaDocs.
Lock Table Maintenance
Lock Table Maintenance allows you to unlock any records that are being accessed by another user. The record has to have been open for a minimum of ten minutes. Access to this tool can be restricted through user permissions.
Management Summary
The Management Summary contains a library of reports that display in a graphical format.
Report Manager
The Report Manager contains a library of reports created by SedonaOffice for your use. You will find many reports from each module, including RMR tracking reports, a basic balance sheet, and job/service reports.
SedonaSetup
This tool contains the setup tables, processing options, and company information that SedonaOffice needs to run according to your specific needs. Most of this information is filled in prior to your go live date.
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The dashboard is where all open records will be displayed. You can have multiple windows open, and you can maximize and minimize windows.
Explorer Layout
Most items, such as customers, vendors, and parts, will open in a window called an explorer. Each explorer has a similar file tree layout.
The Customer Explorer
The customer explorer is comprised of four areas:
1. Customer Tree (provides access to all records related to the customer)
2. Address Information (changes dynamically based on the selected item in the Customer Tree)
3. Customer Snapshot (includes collections status and last payment information)
4. Dashboard Display (visible when the customer name is selected at the top of the Customer Tree)
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Follow this link to watch instructional videos on the Sales Management and Client Management modules:
Sales Management & New Accounts Playlist
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The Prospects List
The prospects list allows you to keep track of potential customers. You can order the list by clicking on the column headers. You can also filter the view by selecting options from the dropdowns. A prospect in this list will turn red when the follow-up date has passed. 
Reorder the prospect list
1. Go to the Sales Management module.
2. Select Prospects.
3. Click once on the header by which you wish to sort (e.g. Follow-up Date).
4. The list will now be sorted based on the column you selected.
Filter the prospect list
1. Select an option from one of the dropdowns at the top of the prospect list (e.g. Salesperson).
2. The list will now only show prospects within the option selected.
Open a prospect
1. Highlight the prospect you want to open and:
a. Double-click, or
b. Select Open on the bottom right.
View inactive prospects
1. Select the “Show Inactive” checkbox on the bottom left of the Prospects module.
2. The list will now include prospects that have been made inactive.
The Opportunities List
The opportunities list allows you to keep track of current job opportunities. Each prospect can have multiple opportunities. You can order the list by clicking on the column headers. You can also filter the view by selecting an option such as opportunity type.
Reorder the opportunities list
1. Go to the Sales Management module.
2. Select Opportunities.
3. Click once on the header you wish to sort by (e.g. Follow-up Date).
4. The list will now be sorted based on the column you selected.
Filter the opportunities list
1. Select an option from one of the dropdowns at the top of the prospect list (e.g. Opportunity Type).
2. The list will now only show opportunities with the option selected.
Open an opportunity
1. Highlight the opportunity you want to open and:
a. Double-click, or
b. Select Open on the bottom right.
View inactive opportunities
1. Select the “View Inactive” checkbox on the bottom left.
2. The list will now include opportunities that have been made inactive.
Note: If there are multiple opportunities on a prospect, you can inactivate one opportunity without inactivating all opportunities or the prospect.
Enter Prospects
1. Select Prospects in the Sales Management module.
2. Click New on the bottom right to open the New Prospect form.
3. Enter basic prospect information.
a. Required fields
i. Residential or Commercial
ii. Name
iii. Source
iv. Status
v. Temperature
vi. Sales Department
vii. Salesperson
4. Enter the next follow-up date to turn the prospect red when the date passes, if desired. 
5. Do not enter a resolution or resolution date until the prospect has signed or declined the contract.
6. Click Apply.
Note: The buttons in the lower left section of the screen for Email, vCalendar, Create vCard, and Import require you to set up an email application. The Mail Merge button requires setup of letter templates on the server.
7. Enter custom detail information in the Qualifications screen (this can be customized in SedonaSetup > User Defined Setup).
8. Enter contact information in the Contacts screen.
a. Click New.
b. Enter contact name and address.
i. All other fields are optional.
c. Click Save.
d. Repeat for all contacts.
Note: Contacts do not transfer when a prospect is converted to a customer
9. Enter jobs/systems for the prospect in the Opportunities screen.
a. Enter an opportunity title (e.g. “Res-Burg for John Doe” or “CCTV for John Doe”).
i. This title will appear in the Opportunities screen, so give it a name you will easily recognize for the prospective customer. Opportunities usually reflect each install or system type the customer will be purchasing. If you do not wish to track multiple opportunities, enter a generic title here. 
b. Select residential or commercial.
c. Enter the site name (the physical location where the system will be installed).
d. Enter the site address.
e. Enter opportunity information.
i. Required fields
1. System Type
2. Status
3. Quote Type
4. % to Close
f. Enter sales items quoted for this opportunity (optional).
i. You can include all recurring items and installation charges in this area to track quoted prices. Click under Sales Item and use the dropdown that appears to choose from your items. These items are set up in SedonaSetup > Sales Items. 
Example:
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g. Click Save.
Note: when leaving the opportunities screen, you will be prompted to save before exiting. Do not choose to save the new record (SedonaOffice automatically opens a new opportunity after saving the one you just created).
10. View or enter notes for this prospect in the Note Log screen.
a. Automatic notes will be logged by the program for all actions taken on this prospect.
b. You can also enter manual notes in this area.
Resolving an Opportunity
Upon winning or losing a prospect, you will have to first resolve the opportunity. If accepted, you can then turn the prospect into a new account in SedonaOffice. If declined, you will inactivate the opportunity and/or the prospect. If the prospect has more than one opportunity, make sure to close each opportunity without choosing ‘Create Customer’ or ‘Inactive Prospect’ until you reach the last opportunity.
Resolving an accepted (i.e. sold) opportunity
1. Open the prospect either through the prospects or the opportunities list.
2. Change the status of the prospect to “Sold” from within the Prospect button.
3. Choose a Resolution (i.e. accepted or declined).
4. Choose a resolution date.
5. Go to the Opportunities button.
6. Double-click on the opportunity.
7. The opportunity information will be displayed.
8. Click Resolve at the bottom left.
9. Choose “Accepted” in the drop-down list.
10. Enter a resolution date.
11. Select the main competitor for this opportunity, if applicable.
12. Select “Close Opportunity.”
13. Select “Inactivate Prospect” (if this is the only opportunity for this prospect).
14. Select “Create Customer” (if this is the only opportunity for this prospect).
15. Do not select “Create Job” at this time. You will begin a new job after the customer has been fully created. 
16. Click Save.
a. If the customer has more than one open opportunity, follow steps 6 through 12 and save without inactivating the prospect.
b. Inactivate all opportunities until you reach the last opportunity. At this point, you can choose “Inactivate Prospect” and “Create Customer.”
Note: If you selected Create New Customer, the New Customer Setup screen will be displayed at this time. You can find instructions for completing a new account here.
Resolving a declined (i.e. lost) opportunity
1. Open the prospect either through the prospects or the opportunities list.
2. Change the status of the prospect (e.g. “Lost”) from within the Prospect button.
3. Enter a resolution date.
4. Go to the Opportunities screen.
5. Double-click on the opportunity.
6. The opportunity information will be displayed.
7. Click Resolve on the bottom left.
8. Enter a resolution date.
9. Choose “Declined” in the drop-down list.
10. Select the main competitor for this opportunity, if applicable.
11. Select “Close Opportunity.”
12. Select “Inactivate Prospect” (if there are no other open opportunities for this prospect).
13. Do not select “Create Job” or “Create Customer.”
14. Click Save.
a. If the customer has more than one open opportunity, follow steps 4 through 11 and save without inactivating the prospect.
b. Inactivate all opportunities until you reach the last prospect. At this point, you can choose “Inactivate Prospect.”
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1. Expand the Client Management module.
2. Select New Customer.
a. If you are creating a customer from a prospect record, this form will open automatically once you select “Create Customer.”
3. Select “Show Explorer” and “Create New System” in the upper right corner of the form.
a. These checkboxes will give you access to the system tab in this form, and it will open the customer page upon completion of the form.
4. The first tab, Customer Information, will open.
a. Enter the customer name and the bill to information, including the bill to name and address and whether it is a residential or commercial billing address.
b. Enter all basic customer information.
i. Required fields
1. Name
2. Billing Address
3. Customer Type
4. Default Terms
5. Salesperson
6. Branch
ii. Optional fields: 
1. Old Customer ID: usually filled out for reference after conversion from another software.
2. Tax Exempt #: this field is informational only; you must enter the tax-exempt number on the site in order to prevent invoices from charging tax.
3. Bypass RMR Increases Until: this field is informational only; you MUST enter this date on the system or recurring item in order to prevent this customer from receiving RMR increases until the entered date.
4. Blanket PO: the PO number entered here will show on every invoice created on this account.
5. Expiration Date: expiration date for the blanket PO number.
6. Chain Account: groups customers together who have something in common, such as routing area, which can then be viewed in Client Management/Chain Accounts.
7. Customer Groups: groups customers together so that user access can be restricted to specific groups. Usually used in conjunction with multiple branches.
c. Select the invoice printing options for the customer.
i. The checkboxes at the bottom of the form under Invoice Printing will determine:
1. if the customer should receive a printed cycle invoice
2. if they should be excluded from collections
3. if each site on the account should receive a separate cycle invoice
4. if this customer should be charged late fees
5. if they will be included in statement printing
5. Go to the second tab (Site Setup).
a. Enter the number, name and address for the first site if it is different than the billing information (more sites can be created later).
b. Determine if the site is residential or commercial.
c. Enter basic site information.
i. Required fields
1. Customer Since date
2. Tax Group service and miscellaneous invoices
3. Cycle Tax Group for cycle invoices
6. Go to the third tab (System).
a. Enter a system account number.
Note: for monitored accounts, this is the central station number; for other accounts, enter a unique number, such as the customer number and the system type (e.g. 10427-CCTV)
b. Enter other basic system information.
i. Required fields
1. System Type
2. Panel Type
3. Warranty: allows service tickets to bill according to warranty rules.
4. Service Level: allows service tickets to bill according to service level rules.
5. Primary Service Company
ii. Optional fields:
1. Panel location 
2. Monitored By
3. Memo: appears on service tickets
4. Alternate Service Company 1&2: companies that will perform service in the event that your company will not be servicing this system.
5. Comments: appears on service tickets.
6. Contract info: if a cancellation is performed through the Cancellations module, the balance of contract will be calculated from this information.
7. OK to Rate Increase After: prevents RMR items from receiving increases until the date entered.
8. Cycle Purchase Order Info: PO number entered here will appear on cycles invoices only until expiration date entered.
7. Go to the fourth tab (RMR).
Note: the RMR tab is usually skipped because RMR for new accounts is typically set up in the job to provide accurate job costing. Only complete this tab is you are not planning on entering a job into SedonaOffice for this customer.
a. Click New.
i. Recurring Item: loads all recurring type items from SedonaSetup>Invoice Items.
ii. Description: automatically loads from item, but can be changed per RMR item.
iii. Sub Item Of: allows you to group RMR items together so that SedonaOffice users can view the detail, but the customer cannot. All RMR items on a site with the same Sub Item Of will be grouped together on cycle invoices.
iv. Bill Cycle: frequency at which you will bill this recurring item (i.e. monthly, annually, etc.).
v. Next Cycle Date: month you will begin to bill the recurring item.
vi. Memo: appears on cycle invoices.
vii. Reason for Add: used in RMR reporting.
viii. RMR Start Date: date you will begin to bill the recurring item. If this date is set prior to the next cycle date, it will be used for reporting purposes only; the RMR will begin billing on the next cycle date. If the start date is set after the next cycle date, the RMR item will be prorated for the first month; the RMR will begin on the start date.
ix. Comments: internal only.
b. Click Add and repeat for each item.
8. Go to the fifth tab (Custom Fields).
a. Fill out any custom fields that your company has created. These can be set up in SedonaSetup/Custom Fields Setup (Customer) in the CM area. 
b. Click Save.
9. The new customer’s account will open.
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Follow this link to watch instructional videos on the Client Management module:
Client Management Playlist
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Customer accounts can have as many sites and systems as needed, with as many billing or site contacts as necessary within each record. Billing information is held at the customer level, and multiple billing addresses can be set up. Invoices and recurring items can point to whichever billing address is appropriate. 
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1. [image: ]Open the customer page.
2. Right click on the Bill To folder.
3. Select New Billing Information.
4. Enter the billing information.
a. Required fields
i. Residential or Commercial
ii. Name
iii. Address	
iv. Phone number
v. Indicate if this is the primary billing address.
1. Checking primary will remove this setting from the current primary billing address. 
vi. Check Primary RMR/Service/Job/Other to indicate the types of invoices that should be sent to this billing address.
vii. Check “Email Invoices.”
1. Select this option if you are using SedonaEmail or SedonaSync, and enter an email address.
5. Click Save.
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1. Right click on the bill name/address under Bill To.
2. Select Edit Billing Information.
3. Add or delete desired information.
4. Check Inactive to inactivate the address without permanently removing it from the account.
5. Click the “delete data” button at the top left in the toolbar to permanently remove the address.
a. You must have another primary bill to in place before you can take this step.
6. Click Save.
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Add a Billing Contact
Option one
1. Open the customer page.
2. Under Bill To, expand the billing address where you wish to add a contact.
3. Right click on Contacts.
4. Select New Bill Contact.
5. Enter the contact information.
a. Required fields
i. Name
ii. Phone number
6. Check Collection Contact to display this contact when using the Collections module.
7. Check Cycle Invoice Contact to include this contact on future cycle invoices.
8. Make at least one selection in the Bills and Sites tab.
a. A contact can be assigned to as many sites or bill addresses as necessary.
b. Making these selections will allow the user to select this contact on invoices, service tickets, etc.
9. Click Save.
Option two
1. Expand the Bill To folder in the customer explorer.
2. Right click on a billing address.
3. Select Edit Billing Information.
4. Go to the Contacts tab.
5. Select New.
6. Complete the new contact form.
7. Click on the Bills and Sites tab and make at least one selection.
8. Click Save.
Note: you can follow these same steps to create a site contact by starting from the Sites folder.
Edit a Contact
1. Click on Contacts.
a. Contacts can be found under billing and/or site folders.
2. In the dashboard display, right click on a contact’s name and select edit or double click on the name.
3. Add or edit the appropriate information and select Save.
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Add a Site
1. Right click on the Sites folder and click on New Site.
2. Complete the Site tab.
3. Click Save.
Edit a Site
1. Open the customer page.
2. Right click on the appropriate site.
3. Select Edit Site.
4. Edit the site information.
5. Click Save.
Note: Make sure that your selected tax groups match the site address.
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Add a System
1. Open the customer’s page.
2. Expand the Sites folder, and then the site to which you are adding a system.
3. Right click on Systems and select New System.
4. Fill out available information for the new system.
5. Click Save.
Note: The system number should be a unique number; system account numbers cannot be duplicated unless specified in SedonaSetup > Setup Processing (AR). If this is a non-monitored account, it is recommended that you develop a unique numbering system for these situations, such as customer number-system (i.e. 10589-CCTV).
Edit a System
1. Click on Systems under the correct site folder.
2. Right click on the system.
3. Select Edit System.
4. Make your desired changes.
5. Click Save.
Note: Recurring items and equipment are usually added through jobs, not manually entered onto system records.
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1. Open a customer.
2. Right click on Recurring near the bottom of the customer tree.
3. Select New Recurring and choose the system.
4. The New Recurring Item form will open.
5. Enter the required data.
a. Required fields
i. Recurring Item
ii. Description
iii. Bill Cycle
iv. RMR Amount
1. Deselect “Enter as Monthly Amount Only” to enter the cycle amount
v. Next Cycle Date
vi. Reason for Add
vii. Recurring Start
b. Optional fields
i. Sub Item Of: allows you to group RMR items together so that SedonaOffice users can view the detail, but the customer sees only the item select in Sub Item Of on their invoice.
ii. Invoice Group #: leave blank to default to group 0.
iii. Renewal: can be used in Company Rate Change function as criteria for company-wide rate increase/decrease.
iv. Rate Increase Date: prevents this item from being increased until this date.
v. Override Percentage
vi. PO Number: will appear on invoices created from this RMR item.
vii. PO Expires: expiration date for this PO number.
viii. Reference
ix. Comments
x. Memo: appears on the invoice.
6. Click Save.
Note: First of the Month or Day of Service Start options are managed in SedonaSetup > Setup Processing (AR)
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If first of the month billing is turned on for your company:
In the Next Cycle Date field, choose the month that you will begin to bill the customer, i.e. if the install date is February 6th, you will typically bill the customer for the month of February. You may want to prorate for the days in February during which the customer was not monitored, which is done through the cycle start date. Choose a next cycle date of 01-Feb-21 and a cycle start date of 2/6/2021. This will bill the customer for twenty-two days in February and then bill for the entire month starting in March. If you wish to bill the customer for the entire month, simply choose a cycle start date of the first of the month. If this date is set prior to the next cycle date, such as 1/27/2021, it will be used for reporting purposes only; the RMR will begin billing on the next cycle date, i.e. 01-Feb-21.
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If bill on service start date is turned on for your company:
Choose the day of the month that the service will start in the Bill on Day dropdown. Match the recurring start date to the bill on day. The customer will be cycled according to this bill on day for this recurring item from now on.
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Process Cancellations
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1. Open Cancellations under Client Management in the Company File Tree.
2. Select New at the bottom right side of the screen.
3. From the customer look up screen, search for and choose the customer being cancelled.
4. Complete the cancellation form.
a. Choose the reason for cancel in the RMR Reason dropdown.
b. Choose a Cancel Profile according to the type of cancellation (each cancel profile has a unique task list).
c. Optional: Enter pertinent information in the Reference field, i.e. amount owed on account, employee responsible for completion of cancellation, etc.
d. Notice Date: date the customer notified the company of the cancellation.
e. Effective Date: the last day the RMR will be billed in SedonaOffice. This date will be entered as the end date on RMR items.
f. Follow Up Date: date you wish to check back on the cancellation’s progress. The customer name in the cancellations module will turn red when this date has passed to help you track the work that needs to be done for each cancellation.
g. CS Cancel Date: the last day that your central station will monitor this account. This date only appears when CS Cancelled is checked.
i. Full Cancellation:
1. This button will cancel all sites and systems
ii. Partial Cancellation:
1. Do not select the Full Cancellation button
2. From the Sites tab, choose which site is being cancelled
5. Click Save.
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1. Double click on a cancelled customer in the queue.
2. Enter a new follow-up date, if necessary.
3. Click on the Tasks tab.
4. Check each task as you complete it.
a. When all tasks are flagged, a Completed checkbox will appear at the bottom left side of the screen.
5. Check Completed when you are ready to finish the cancellation, remove the customer from the cancellations queue and give the customer a ‘CANC’ status in SedonaOffice.
6. Select Save.
Note: When viewing the cancellations list, select the Completed Only checkbox in the bottom left corner to show and edit a previous cancellation.
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The collections module consists of “queues” of overdue customers, separated between automatic and manual queues. Automatic queues indicate the number of days past due (i.e. 30-59 Days Past Due) and will be automatically populated when the queue is refreshed. Manual queues do not automatically populate and are created to group similar customers together (i.e. Do Not Call or Sent to Collections). Customers must be manually moved from an automatic queue to a manual queue. 
1. Expand the Client Management module, then click on Collections.
2. Click on the refresh button in the Collection Profile toolbar.
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3. Select Yes when you are prompted to run the refresh for all profiles.
Note: You must age your database regularly in order to use the Collections module effectively.
4. Double click on a collections profile to open the list of customers in that queue.
5. Double clicking on a customer name will open the customer record.
6. The queue toolbar has seven buttons that edit the queue.
a.  Add Customer to Queue
i. After clicking this button, choose a customer in the explorer and double click.
ii. Enter the follow up date, status and any pertinent notes.
iii. Save.
b.  Add Collections Notes
i. Highlight a customer’s name (click on the name once) and click on this icon.
ii. Type your note in the text box and click Add Notes (these notes should be used to document the outcome when contact is made with the customer).
iii. All saved notes will show up in the gray text box under Current Collections Notes.
c. [image: ] Add Manual Event
i. Click this icon to document action taken on a customer’s account related to collections work, such as calling for payment, leaving a message or sending a letter.
Note: The manual event button is preferable to the collections note button because it allows for much more detail.
ii. Enter a follow up date. This step is essential for exceptional customer service. In a case where you are waiting for a response from an email or another type of inquiry, set the date for the following day or the next day you will be making collection calls. Be sure to notate the account with action notes. For collection calls or letters, generally Astute recommends placing them 10 days apart, so select the follow up date accordingly. For example, if calling on the 10th of the month, the follow up date would then be the 20th. However, if the follow up date falls on a weekend or holiday, select the next business day.
iii. Set the status to the action you want to take next. For example, if the customer is 20 days past due and you just made a call, set the status to the next appropriate action, which would be a 30-day letter. In ten days when you send the 30-day letter, reset the status to “40-day call next”.
iv. Select the type of activity, e.g. called for payment, sent letter, left message.
v. Enter a note. The note you enter will ideally contain the invoice numbers you contacted the customer about, your message and the customer’s response, if applicable. Astute employees enter notes using a specific structure that includes the date, initials and an action code. Then additional codes are added throughout the note, if needed, along with all other relevant info.


Note Structure: xx/xx/xx-INITIALS|CODE: (note)
Example note: 05/08/19-JMH|EML: (note)
Astute collection codes:
	Code
	Description

	EML:
	Sent email

	DOC:
	Sent statement or invoice

	TEL:
	Made phone call 

	LTR:
	Sent letter

	PMT: 
	Received payment

	WEB: 
	Internet research

	HLP:
	Ask for help with customer


Astute has a Flex report called Collections Activity designed to analyze activity by collection code. To use this report, you must enter the codes from the table above as shown, including the colon. Astute recommends performing collection efforts according to the following timeline.
	Days Past Due
	Activity
	Status

	10
	Reminder Email
	20-day call next

	20
	Called for Payment
	30-day letter next

	30
	Sent Letter
	40-day call next

	40
	Called for Payment
	50-day call next

	50 
	Called for Payment
	60-day letter next

	60 
	Sent Letter
	70-day call next

	70
	Called for Payment
	80-day call next

	80
	Called for Payment
	90-day letter next

	90
	Sent Registered Letter
	Legal next

	110
	Called for Payment
	At Legal or In Mgmt Hold



d.  Move to Another Collection Queue
i. Highlight the appropriate customer and click the Move to Another Collection Queue icon when you would like to move a customer from an automatic queue to a manual queue or from one manual queue to another. Customers should not be moved manually from one automatic queue to another automatic queue.
ii. Double click on the queue you want the customer to be moved into.
iii. SedonaOffice will prompt you to move the customer.
iv. Select Yes and the customer will disappear from the list.
e.  View Event History
i. This icon lists all activity and actions taken on customers within this queue. Notes will appear within this list so you can track the progress of each collections queue.
f.  Mail Merge
i. Click this icon to generate collections letters for the highlighted customers (email support@astutefinancial.biz for instructions on setting up Mail Merge)
g. [image: ] Select All in Queue
i. This icon highlights all customers in this list so you can use mail merge to contact all customers
[bookmark: _Toc53932564]Removing a customer from collections
To entirely remove a customer from collections, they must first be moved from a sequenced queue to a non-sequenced queue. You can then remove them from collections. Selecting “No Collections” when editing the customer will prevent them from being pulled into collections the next time the queues are refreshed.
Removing from a sequenced queue
1. Highlight a customer record in collections.
2. Click on Move to Another Collections Queue.
3. Double click on a non-sequenced collection queue.
4. The customer has now been moved into a non-sequenced queue and will stay in this queue indefinitely unless they are removed.
Removing from a non-sequenced queue
1. Go into a non-sequenced collections queue and highlight a customer.
2. Right click and select Remove Customer from Collections.
Prevent customers from entering collections
1. Open the customer account.
2. Right click on Customer Information and click Edit Customer Setup.
3. Check “No Collections.”
4. Click Save.
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[bookmark: _Toc53932565]Accounts Receivable
Follow this link to watch instructional videos on the Accounts Receivable module:
Accounts Receivable Playlist
[bookmark: _Toc53932566]Process Cycle Invoicing
Before processing cycles, customers must be set up with active RMR items. The customer’s RMR will only run if the Next Cycle Date on the recurring item matches the cycle date chosen in Cycle Invoicing. 
[bookmark: _Toc53932567]Create a Cycle Invoicing Batch
1. Open Cycle Invoicing under the Accounts Receivable module.
2. Select New.
3. Choose the month for which you are billing.
4. In the ‘Include Customers with Bill Day’ dropdown, allow the default to stay at 28.
a. You can cycle customers according to Bill On day or on the first of the month. This setting is chosen in AR Setup Processing in SedonaSetup. If your bill cycle is not the first of the month, you may use this selection to determine which customers with certain billing days will be cycled. For example, choose a bill day of 15 to run cycle billing for customers with a bill day between the first and the 15th of the month.
5. Select the branch or check All Branches.
6. Save.
7. SedonaOffice will ask if you are ready to begin; select Yes.
a. The cycle is now available in Cycle Invoicing. To view the customers in this cycle, right click on the cycle batch and select Print > Cycle Detail. If this report shows customers with incorrect dates or charges, you must correct the customers’ recurring items, then delete the cycle and recreate it. Right click on the cycle and select delete to remove it. 
8. Highlight the cycle and select Edit.
9. Fill out the Cycle Invoicing Process according to your company’s setup; below are common settings:
a. Description: leave at default.
b. Category: Monitoring (or a similar category).
c. AR Account: leave at default.
d. Terms: Due on Receipt.
e. Invoice Date: Date of Process.
f. Invoice Description: Security Services (or a similar category).
g. Aging Date: Leave as the first of the month. Most terms do not make use of aging date.
h. ACH Hold Date: First of the month.
i. Choose the date you wish to charge cards/banks for those customers who are set up for automatic payments.
j. Memo: Optional, your company’s preference.
10. Save: come back and edit the cycle later.
   - or -
11. Post: finish cycle invoicing and send to the print queue (only Post when you are completely done and ready for invoices to be created).
12. Upon posting, the Apply Cycle Invoicing Credit form will open.
a. You can either apply credits to the invoices you just created, or
b. Close to leave credits on customers’ accounts.
Note: You can apply these credits later through the Unapplied Cash/Credit function in the Accounts Receivable Module. Simply highlight the credit, select Apply, choose the invoice to which you’re applying the credit, and save.
[bookmark: _Toc53932568]Process Statements
[bookmark: _Toc53932569]For Multiple Customers
The Statements function allows users to generate statements for the entire customer database within a set of chosen criteria. When printing invoices, users have the option to print in Invoice/Statement format and choose “Update Last Statement Date” instead of or in addition to using the Statements function. Customers will only be pulled into the statement function if “Print Statements” is chosen in their Customer Setup.
1. Open the Statements function under Accounts Receivable.
a. The aging process will run at this point and may take a few moments. This is also an easy way to age your customer database, even if you do not wish to run statements. 
2. Choose your statement settings.
a. Last Statement Date
i. Defaults to today’s date.
ii. Will prevent customers from entering the list who have already received a statement as of the date entered.
b. Create Statements For
i. All Customers
1. Creates statements for all customers, regardless of the amount due on the account. Includes negative balance and zero balance due customers.
ii. All Non Zero Customers
1. Excludes customers with zero dollars due on their account.
2. Includes customers with negative or positive balances due on their accounts.
iii. AR Balance
1. Choose a minimum balance due per account and a minimum number of days past due to exclude customers that do not fit the criteria.
iv. Credit (negative) balances only.
c. Branch
i. If you have multiple dealers or branches, choose one or more of these.
   - or -
ii. Choose “All.”
d. Separate Statement by Billing Address
i. If deselected, each customer account will receive one comprehensive statement.
ii. If selected, each billing address will receive a statement for the sites assigned to that billing address.
e. Print Options
i. Choose a statement date.
ii. Choose a due date or check “Hide the Due Date.”
iii. If you wish to show the account’s open cash and credits on the statement, click “Show Open Credits.”
iv. Select how to sort the statement list.
v. Enter statement memos for customers who are over 30, 60, and 90 days past due.
Note: Print options should be managed in SedonaSetup > Late Fee Rules so they will default correctly in the Statements function.
f. Recalculate and Show Late Fees.
i. Minimum Days Past Due.
ii. As Of: this date will default to today’s date, but you can backdate to exclude invoices, if necessary.
iii. Minimum Invoice Balance: set to $0.01 to include all invoices.
iv. Annual Interest Rate: will calculate amount due according to the entered percentage at an annual rate.
v. Minimum Charge: each statement will receive a late fee equal to this amount if the recalculation of the late fee is less than the minimum charge entered here.
Note: Late fees can be recalculated and applied to the customers who meet the chosen statement criteria if this option is checked. If you do not wish to apply or change late fees, deselect this checkbox. These settings should be chosen in SedonaSetup/Late Fee Rules so they will default correctly in the Statement function.
3. Click on the second tab, Statement List.
a. Click Refresh List to show all customers who will receive a statement according to the chosen settings.
i. Late fees are calculated and added to customer accounts at this time.
ii. Late fees in SedonaOffice are not actual records on the account, like invoices, but are just calculated values that can be collected or not at your company’s discretion.
b. Click Print List to print the current list of customers before creating the statements.
c. Click Create Statements when you are ready to print statements.
d. Once this is chosen, you’ll receive the option to click Preview Statements, which will allow you to print.
e. You can also choose BFIS Export to export the list to Bridgestone for printing.
4. When done, click Close.
[bookmark: _Toc53932570]For a Single Customer
Statement Only
1. Open the customer’s account.
a. Right click on the bill to address and click Print Statement.
i. This method will show past due invoices connected to this bill to only.
- or -
b. Right click on the Collections folder in the customer tree and click Print Statement.
i. This method will show all balances due for the entire account.
2. The Printing Preferences form will open.
3. In the Format tab, choose appropriate settings, such as showing late fees or open credits.
a. Current late fees can be shown on any statement but cannot be recalculated.
b. If you wish to recalculate late fees, you must do so in Accounts Receivable > Statements or by printing an invoice/statement.
Invoice with Statement Detail
1. Open the customer’s invoice.
2. Go to File > Print Preview.
3. Choose either Invoice Statement or Bridgestone Standard in the form field.
4. The Printing Preferences form will open.
5. Go to the Statement Detail tab.
6. Select “Include Statement.”
7. Select your desired options.
8. To show late fees, go to the Late Fees tab and select “Show Late Fees.”
9. Click OK.
 Remove a Late Fee
1. To remove a late fee from an account, right click on the Last Late Fee in the Customer Snapshot section of the customer record.
2. Click Remove Late Fee.
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3. To remove a late fee for all customers, open the Statements function.
4. Click Recalculate Late Fees and enter zeroes in the calculation fields.
5. Click Refresh List on the next tab and all late fees will be removed from all overdue invoices in the list.


[bookmark: _Toc53932571]Manage the Print Invoices Queue
[bookmark: _Toc53932572]Printing and Exporting Invoices
1. Expand the Accounts Receivable module and select Print Invoices.
2. Use the filters on Select Invoices window to build the invoice queue.
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a. Required filters
i. Branch
ii. Invoice type
iii. Bill-to type
iv. Type of customer
b. Filter options and sorting.
i. Show master cycle invoices.
1. You must select this option to print cycle invoices created for master accounts.
ii. Only show invoices in the print queue.
1. Invoices are in the print queue when they have “Add to Print Queue” selected.
2. Usually you will leave this selection turned on when working with your print queue to avoid sending invoices that have already been printed.
3. Deselect this option and use the additional filters (dates/invoice numbers) to view invoices that are not currently in the print queue.
iii. Show ACH pending invoices.
iv. Show BFIS pending invoices.
v. Hide invoices with $0 balance due.
1. Usually this option should be selected to avoid sending unnecessary invoices
2. By default, Bridgestone will not mail $0 balance invoices.
vi. Filter for emailing
1. Excludes invoices marked for the email queue via SedonaEmail.
vii. Sort by
1. Determines the order that invoices are displayed in the queue.
c. Additional filters
i. Dates
ii. Invoice Numbers
iii. Customer group
1. Only available if your company has this feature enabled.
d. Additional buttons
i. Customers
ii. Subaccounts
3. When you are finished making your selections, click Create List to see the invoice queue.
4. Deselect invoices that do not need to be printed.
5. Choose an invoice format from the “Print On” dropdown box.
a. Select BFIS Export to send selected invoices to Bridgestone for printing.
6. Select Print or Preview to print selected invoices.
a. Print will build the file and automatically start the printing process.
b. Preview will open a PDF file and build it for viewing before printing.
7. After printing, select Mark as Printed to permanently remove checked invoices from the print queue.
8. Select Remove from List to temporarily remove invoices from the queue.
[bookmark: _Toc53932573]Create Miscellaneous Invoices
[bookmark: _Toc53932574]From the Accounts Receivable Module
1. Expand the Accounts Receivable module and select Invoicing.
2. Enter a customer name or number in the Customer ID field in the top left or use the binoculars to open the search window.
3. Use the buttons next to the billing address and site address to select the appropriate addresses.
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4. Fill out the invoice header.
a. Invoice date
b. Aging date (only important when using Terms that use the aging date)
c. Branch
d. PO Number
e. Warehouse (if adding parts to the Parts tab on the invoice)
f. Term
g. Invoice type (select miscellaneous when not creating invoices through jobs, service or cycle invoicing)
h. Job # (leave blank for miscellaneous invoices)
i. Salesperson (defaults to the customer’s salesperson)
5. Add invoice line items, e.g. Over the Count Part.
a. Enter a quantity and rate.
b. Tax will calculate automatically based on the customer’s tax group.
c. Repeat as necessary for all invoice items.
d. Avoid using job or service items, as these are typically only added to job and service invoices.
6. Optionally, add a part to the Parts tab.
7. Fill out the invoice footer.
a. Description
b. Contact (will be printed on the invoice)
c. Memo (will be printed on the invoice)
d. Complete (deselect this option if you are not done creating the invoice and would like to come back to it)
e. Add to print queue (adds the invoice to the Print Invoices queue in Accounts Receivable)
f. Add to email queue (adds the invoices to the email queue for SedonaEmail)
8. Click Save.
[bookmark: _Toc53932575]From the Customer Explorer
1. Open the customer record.
2. In the Customer File Tree, expand the appropriate site folder.
3. Right click on Invoices.
4. Select New Invoice.
5. Follow steps 3 through 8 above to create the invoice.
[bookmark: _Toc53932576]Create Credits
[bookmark: _Toc53932577]From the Accounts Receivable Module
1. Expand the Accounts Receivable Module and select Credit Memo.
2. Enter a customer name or number in the Customer ID field in the top left or use the binoculars to open the search window.
3. Use the buttons next to the billing address and site address to select the appropriate addresses.
4. Fill out the credit header.
a. Credit date
b. Branch
c. PO Number
d. Warehouse (if adding parts to the Parts tab on the invoice)
e. Salesperson (defaults to the customer’s salesperson)
f. Credit type
5. Add credit line items, e.g. CM-Bad Debt-TX.
a. Enter a quantity and rate
b. Tax will calculate automatically based on the customer’s tax group
c. Repeat as necessary for all credit items
d. It is best practice to use line items that were created specifically for use on credit memos
6. Optionally, add a part to the Parts tab.
7. Fill out the credit footer.
a. Description
b. Credit reason
c. Memo (will be printed on the invoice)
8. Select Future Auto Appy to allow the system to automatically apply the credit on the next invoice based on invoice type (cycle, service, job, miscellaneous, or all types).
a. Be careful with this feature, as you don’t want to accidentally apply the credit to the wrong invoice.
9. Click Save.
[bookmark: _Toc53932578]From an Existing Invoice
1. Right click on the invoice to be credited.
2. Select Create Credit From to create a credit memo with the same line items and information as the invoice.
- or -
3. Select Credit Off Invoice to credit off the invoice with the same line items and today’s date.
a. This method is typically not recommended as you have less control over the credit information.
4. After selecting Create Credit From, the credit memo window will open.
5. Follow steps 2 through 9 above to create the credit memo.
[bookmark: _Toc53932579]From the Customer Explorer
1. Open the customer record.
2. In the Customer File Tree, expand the appropriate site folder.
3. Right click on Credit Memos and select New Credit Memo.
4. Follow steps 2 through 9 above to create the credit memo.
[bookmark: _Toc53932580]Apply Credits
[bookmark: _Toc53932581]To Open Invoices
1. Open the customer record or click on the customer name at the top of the file tree to view the open items page.
2. Right click on an open credit.
3. Select Apply.
4. Choose an appropriate apply date (it is best not to back date).
5. Click Auto to apply the amount of the credit to invoices from oldest to newest.
a. If the credit amount exactly matches an invoice amount, this option will apply the credit to that invoice.
6. Enter amounts in the payment column to distribute the credit manually.
7. Click Save.
[bookmark: _Toc53932582]To Other Items
1. Follow steps 1 through 4 above.
2. Go to the Other tab.
3. Select Miscellaneous to apply the credit to a GL account.
4. Select Refund Check to create a check for the customer.
5. Click Save.
[bookmark: _Toc53932583]Manage EFT Transactions
[bookmark: _Toc53932584]Enter a New Credit Card or Bank
1. Right click on Payment Options in the Customer File Tree.
2. Select “Edit Electronic Funds Transfer.”
3. From the dropdown, choose either New Bank or New CC.
4. Enter account information provided by the customer.
5. Select Recurring if this payment method should automatically be charged for all cycle invoices.
6. Choose Non-Recurring only if the customer wishes to use this payment method to automatically pay all non-recurring invoices (job, service, miscellaneous) up to a set maximum amount. This maximum amount can be entered in the text box that appears after selecting Non-Recurring.
7. Choose a Hold Day according to the day of the month the card should be charged.
a. Choosing 1 to allows the EFT date to default to whichever day is chosen in Cycle Invoicing as the ACH hold date.
b. Choosing 2 through 28 will charge the customer on that day in the first month of their cycle. For example, if 15 is chosen, the invoice is for January though March, the customer will be charged on January 15th.
8. Alternatively, you can enter the number of days after the invoice date to charge the card or bank.
9. Check Print Cycle Invoices if this customer wishes to receive cycle invoices showing that their card or bank will automatically be charged.
a. Note: you will need to select “Show ACH Pending Invoices” when building the invoice queue to print this customer’s invoices.
10. Select the billing address for which invoices should be automatically charged to this card or bank.
[bookmark: _Toc53932585]Using Auto Draft
The Auto Processing checkbox will determine if a card or bank is charged automatically when invoices are created. If you select the checkbox next to Recurring, a transaction will automatically be submitted each time a cycle invoice is created. The Print Cycle Invoices checkbox can be deselected when this is chosen so that the customer will not receive a paper invoice from the print queue for auto-payment invoices. The Hold Day option under Auto Processing will determine on which day of the month the transaction should be created. Only one payment method can be designated as an auto processing card per billing address.
For Cycle Invoices
1. Check the Recurring checkbox to designate that a charge should automatically be created for each cycle invoice that is generated on this account.
2. Enter a number in the Hold Day dropdown.
3. The number you enter in the Hold Day reflects the day of the month you wish to charge the card. For example, entering a 5 here means that the charge will be entered on the 5th of each month/cycle.
4. If you enter a 1 in this dropdown, the card will be charged on the date that is chosen as the ACH Hold Date in the cycle invoicing process each month. Keep in mind that from now on, you will want to pay close attention to the ACH hold date field in Cycle Invoicing. This date will determine when all recurring auto-process cards will be charged if they have a hold day of 1.
5. You should enter a 2 rather than a 1 in the hold day dropdown for customers that want to be charged at the beginning of the month to prevent these customers from being charged automatically on the date chosen in Cycle Invoicing.
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Example: your company may typically generate cycle invoices a couple of weeks before the next month’s cycle, and you charge all credit cards and banks that are set up for auto process on the first of the next month, meaning you enter a hold day of the 1st into Cycle Invoicing. However, one customer does not want their card to be charged until the 5th of each month. You would therefore choose 5 under the hold day dropdown of the EFT setup form and this customer’s transaction will be created but not submitted/charged until the 5th of the next month. All other customers have a 1 in the hold day dropdown of their payment method, so SedonaOffice will look at the hold date in Cycle Invoicing - in this case the 1st - and the card/bank transactions will be submitted on that day.
For Job, Service or Miscellaneous Invoices
1. Check Non-Recurring to designate that a charge should automatically be created for every job, service or miscellaneous invoice that is created for this account.
2. When this is checked, a blank box will appear. This field is where you will enter the maximum daily charge on this card/bank for these types of invoices. For example, enter 500 to indicate that the customer does not wish to be charged more than $500 per day when a job, service or miscellaneous invoice is created on their account.
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[bookmark: _Toc53932586]Enter EFT Transactions
Once all cards and banks are entered, you can begin to submit transactions. This can be done from four different areas within the customer page.
From the File Tree
1. Right click on Payment Methods and choose Enter New EFT Transaction.
2. Select which bank or card you’re charging.
3. Give the payment a description.
4. Enter a hold date (date the card will be charged) and enter a check number if necessary.
5. Check each invoice that should be paid in this transaction or select ‘Pay All Invoices.’
6. The total will add up in the amount column. If there are no invoices on the account or you do not wish to pay off one of the existing invoices, check unapplied cash or advance deposit. You also have the option to put the charge toward Miscellaneous Income by choosing a GL Account. If you need to remove a charge from an invoice, first void the charge from within payments gateway, then open this form and select Void. If you are not able to void, you may need to re-invoice.
From the Payment Method
1. Double click on the card or bank from within Payment Options.
2. Click on New Transaction at the bottom left.
3. Follow steps 2 through 6 above.


From an Invoice
1. Open an invoice and click on EFT at the bottom right.
2. Follow steps 2 through 6 above.
From the Open Items Page
1. Right click on an invoice and select Make EFT Payment.
2. Follow steps 2 through 6 above.
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[bookmark: _Toc53932587]Review Transactions
Use the ACH Batch report in the Accounts Receivable section of Report Manager to determine which transactions have been declined. 
1. Click on EFT History in the customer’s file tree to view all EFT transactions.
2. Pending transactions will show ‘Not Submitted’ until they are processed in EFT Processing.
3. Funded transactions will show a date and batch code.
4. Unfunded transactions will have ‘Declined’ in place of a date.
a. Use the ACH Batch report to determine the reason for decline by the response code. A List of EFT response codes can be found here.
5. Once the transactions have been processed, funded transactions will appear into Payment Processing.
6. Confirm that these charges are in your bank account, and then deposit the batches.
[bookmark: _Toc53932588]Void or Reverse a Payment
Void in SedonaOffice
1. If an EFT transaction has not yet been uploaded, it can be voided from within SedonaOffice.
2. Open the customer account and click on EFT History
3. Double click on the transaction to be voided. 
4. Select Void at the bottom right.
Reverse in SedonaOffice
1. Right click an EFT transaction in EFT history and select Reverse Transaction.
2. Confirm the amount to credit the customer’s bank account.
Reverse in Payments Gateway
1. Go to www.paymentsgateway.net and login.
2. Select search on the left and enter your search criteria (dates/customer name).
3. Select the transaction that needs to be refunded from the list that populates.
4. The details for the transaction will load.
5. Select reverse at the bottom.
6. On the next page, enter the amount to refund and select Reverse.
[bookmark: _Toc53932589]Process Customer Payments
[bookmark: _Toc53932590]Create a Payment Processing Batch
1. Open the Payment Processing function in Accounts Receivable
2. Select New
3. Complete the New Batch Information form
4. Enter the Tape Total as the sum of all checks being entered
5. Click Save
6. Highlight the batch you just created and select Enter Payments or double click
7. Select the customer (using the search binoculars), payment method, posting date, and check date
8. Enter a check number and, if desired, an invoice number and memo
9. Enter an amount for the payment
10. All invoices currently on the selected customer’s account will appear in the middle of the form. Select Auto at the bottom right to pay invoices from oldest to newest up to the amount entered
11. To pay a specific invoice, type in the amount under Payment rather than selecting Auto
12. If there is not yet an invoice on the account, you can click on the Other tab to apply the payment in other ways.
a. Choose Late Fee and enter the amount to apply as a late fee:
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b. Choose Unapplied Cash to put cash on the customer’s account that can be applied to an invoice later:
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c. Choose Advance Deposit to apply the payment to an open job that has not yet been invoiced. Select the job number and amount to apply:
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d. Choose Miscellaneous when you want to apply the payment directly to a GL Account. For example, if you cancel a customer and credit off all invoices because you do not expect payment, but then you receive payment later, you can choose a GL Account rather than re-activating the customer:
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13. After entering all payment data, use the green arrow at the bottom to scroll right and start a new payment for the batch
14. View previously entered payments for the batch using the green arrows or by selecting View Checks on the bottom left
15. Click Save
16. If all payments entered are equal to the batch total, SedonaOffice will ask if you are ready to tag the batch as ready to deposit
17. Select Yes
[bookmark: _Toc53932591]Deposit a Payment Batch
1. Expand the Accounts Receivable module and select Payment Processing
2. Make sure the Ready checkbox on the far left is checked on the batch you wish to deposit
3. Select Deposit at the bottom right
4. Choose a Deposit Date, Branch, and the Bank Account into which the money was deposited
5. Enter a description to label the batch
6. If the batch is for a lockbox, label it accordingly, i.e. LB 2020-01-16
7. Select the checkboxes of the batch or batches being deposited
8. Click Save
9. If you selected ‘Print Deposit Ticket’, the print preview screen will display
10. Print your deposit summary to keep with the checks/check stubs and/or bank deposit slip
11. Close out of Payment Processing and reopen it to fresh the batch list
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Note: You can review deposited batches by selecting the View Deposits button or by checking Show Deposited Batches.
[bookmark: _Toc53932592]Process Customer Refunds
1. Open Write Checks in the Accounts Payable module
2. Choose the bank account you are using to refund the customer
3. Check the Customer radio button
4. If you are printing this check, click In Print Queue. If not, fill in a check number from the check you’re manually writing. 
5. Search for the customer and the address will automatically populate
6. Enter date, amount, and memo
7. Choose a GL account and category
8. Enter the amount of the check
9. Fill out the Job and Type section if this check is related to a specific job. If not, deselect Show Job Cost
10. Click Save or Print
Note: To refund a customer’s bank account or credit card, you can complete a refund through your virtual terminal in Payments Gateway or by right clicking on an EFT transaction from the customer record and selecting Reverse Transaction. To reflect this refund in SedonaOffice and re-establish the balance of the invoice, you can start a new invoice and use a “Re-Invoice” line item.
[bookmark: _Toc53932593]Age the SedonaOffice Database
In SedonaOffice, the aging process must be run in order to update the AR_Customer_Aging table, which contains current balance due amounts and dates for all customer invoices, credit memos, unapplied payments, and late fees.
This means that databases must be aged on a regular basis to ensure that past due balances are reflected correctly. This affects many areas that pull directly from the AR_Customer_Aging table for current open balance or past due information, including the collections module, aging reports and customer dashboards, among others.
[bookmark: _Toc53932594]Age One Customer
1. Right click on Aging in the customer tree
2. Select Age Customer
[bookmark: _Toc53932595]Age All Customers
From the Statements Module
1. Click on Statements under Accounts Receivable in the company tree
2. This message will appear while the database is aging:
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3. Afterward, you can close the statements function
From the Current Aging Report
1. In Report Manager, double click on the Current Aging report
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2. Check “Reage All Customers,” then click Ok

[image: ]

Using the Auto Aging Wizard
Bold can help you set up the Auto Aging Wizard on your SedonaOffice server. It can be set to age your database on a nightly or weekly basis. This method prevents you from having to manually age your own database.


[bookmark: _Toc53932596]Job Management
Follow this link to watch instructional videos on the Job Management module:
Job Management Playlist
[bookmark: _Toc53932597]Using the Job Queue
The Job Queue is a sorting and filtering system for all jobs within your company. You can view and access all jobs from this list. Double click on a line or select Open at the bottom of the screen to open a job.
[image: ]All Jobs
This button shows all jobs within the criteria designated by the filtering dropdowns on the top of the screen. If all dropdowns are set to all, every open job will be displayed. 
[image: ]Ready to Invoice
This button shows jobs with approved tasks that have been flagged for invoice. If you need to invoice a job and do not see it in this list, go into the Tasks list in the job and flag a task for invoice. 
[image: ]Unscheduled Jobs
Use this button to quickly find all jobs that still need to be scheduled.  
[image: ]Schedule 
Legacy appointment scheduler.
[image: ][image: ]Appointment Summary
This button will open a new window where you can view and schedule appointments. Use the date dropdown to select a day to view. Using the top left dropdown, if you select Ticket, the Service module will open to schedule a new ticket. If you select Job, the new job screen will open.
[image: ]QuoteWerks
If your company has QuoteWerks, this button will open the Orders to Process screen, where you can import jobs.
[bookmark: _Toc53932598]Managing a Job
[bookmark: _Toc53932599]Creating a New Job
From the Customer Page
1. Open the customer explorer
2. Expand the appropriate system folder
3. Right click on Jobs and select New Job
From the Job Queue
1. Open the job queue under Job Management in the Company File Tree
2. Click new at the bottom of the queue
3. Search for the customer using the Customer Lookup binoculars
[bookmark: _Toc53932600]Entering Job Data
Work Order
1. [image: ]Complete the Work Order entry form
a. Job number, tax group, branch, and salesperson are automatically filled in by SedonaOffice. Make sure to look over these fields and correct if necessary.
b. Enter projected start and end dates if you know when this job will take place. 
c. You do not need to enter a tech under Installer. Tech will be scheduled later in the job.
d. Required fields:	
i. Job Type
ii. Install Company
iii. Sold Date
e. Enter text in the Notes field that reflects the nature of the job
2. Click Apply
Job System
Always use an existing system; if there is not an existing system, create one first and then start the new job.
1. To pull in an existing system:
a. Deselect the New System checkbox
b. Click on the import button that appears next to System Account
c. Double click on the system to which you are assigning the job 
d. SedonaOffice will ask if you want to import system information
e. Select Yes
f. Review all other information for accuracy
g. Click Apply
Tasks
This section displays a list of general tasks that must be completed during the course of the job. This list is customizable in SedonaSetup according to your company’s preferences. Each job type can have a unique task list. Each task has a list of users who can sign off on the task. This will allow you to prevent a job from being scheduled, invoiced, closed, etc. without the appropriate users completing their tasks. Approve tasks as you complete each one. A job can only be closed once all tasks are approved and all items are invoiced.
1. Right click on the first task
2. Select Approve Task
3. The line will be time stamped and marked with a username. To reverse the approval, right click on the task and select Unapprove Task.
4. Tasks must be approved in order. To reorder the list, highlight a task and use the green arrows on the right side of the screen to move the task within the list.
5. To delete a single task from the current job, highlight a task and select Remove.
6. To add a task to the job, select New, fill out the dropdown options at the bottom of the screen, and select Save.
7. Tasks that are marked with a ‘Y’ in the Invoice column allow you to create an invoice after they have been approved. You cannot invoice a job until a task marked ‘Y’ for invoicing has been approved.
8. Click Apply before you move on to the next screen.
Installs
These items will appear on invoices generated from the job.
1. Click New
2. Choose an appropriate invoice item. If you are charging a flat rate for the install, enter a general item, e.g. Install Security System. If you would like to separate the charges (usually for tax purposes) for parts and labor, add one item for parts and one for labor.
3. Choose an appropriate Phase Code
a. Phases are assigned to each task in the task list and to the Install items to prevent a job from being invoiced until all tasks in a specific phase have been approved.
b. Choose different phase codes for different install items to invoice parts of the jobs separately.
c. For example, if a job has two phases, pre-wire and trim, you may create an install item called Advance and assign it to the pre-wire phase. The second item, Job Labor, is assigned to the trim phase. The Advance item may be invoiced right away. As soon as all pre-wire tasks have been approved, the Job Labor item will become available to invoice.
4. Leave Cost Type as is.
5. Enter an appropriate quantity.
a. This is applicable when you want to show the customer a specific rate multiplied by the quantity, typically when charging on a time and material basis.
6. Enter an amount to charge in the Unit Price.
7. Enter Labor Units as the estimated number of hours it will take the tech to complete the job.
a. Enter the total estimated house for all techs on the job (e.g. if there will be three techs on site for 8 hours, enter 24 hours).
8. Click Save
Recurring
1. Required fields:
a. Recurring Item
b. Bill Cycle
c. RMR Amount
2. Click Save
3. Enter another recurring item if necessary and save each time
4. Click Apply
Note: Enter a Sub Item Of if this customer has more than one recurring item and you wish to only show one line item on the invoice. Each item should be grouped under the same Sub Item Of to group the charges together on the invoice.
Materials
1. [image: ]Click under the Part header on an empty line.
2. Click on the ellipsis button that appears.
3. Check Pre-Load Parts to load a list of all parts or use the lookup bar to search for parts by name.
4. Hold Ctrl on your keyboard to choose multiple parts to add.
5. Click Select.
6. Enter quantities for each part.
7. In the location column, enter the location for the part.
8. Add identical parts separately if you want to track the location of each part on the site.
9. Check the Stock checkbox if the part is already available in your warehouse. 
10. Deselect the Stock checkbox if you would like to order the part on a PO.
11. Click Apply.
Job Costing
The job costing window tracks the monetary loss or gain of the job. Update estimated cost amounts automatically using the buttons to the right of the estimated amounts. 
Actual costs come in automatically from records in the job.
· Part costs: parts issues
· Labor costs: timesheets
· Other costs: journal entries, AP bills
· Overhead costs: journal entries
· Commissions costs: commissions
Labor
[image: ]The labor section is used to schedule appointments and enter timesheets for technicians. The Schedule function is a legacy module and exists for customers who still prefer to use it, but it should not be used if you are a new SedonaOffice user. All labor will appear in the Appointments section. Job scheduling can be done in this area, or from the Service module calendar (SedonaSchedule).
Create an Appointment from the Job
1. Go to Labor > Appointments.
2. Right click anywhere in the white space.
3. Select Add New Appointment.
4. Choose the date you wish to schedule the job.
5. Fill in the Tech and Time fields or double click on the schedule on the correct time under the tech’s column.
6. Enter estimated length in minutes.
7. Choose the technician’s task in the Job Task dropdown, e.g. Install System.
8. Labor Task can be left blank.
9. Click Apply.
10. Repeat steps for all techs on the job.
Note: Timesheets can be manually entered if necessary, as described below. However, most companies prefer timesheets to be automatically generated using the information entered in the appointment. If you wish to set up automatic timesheets, follow the instructions below.
Manually Enter a Timesheet
1. Go to Labor > Time Sheets.
2. Select New.
3. Make sure the date, installer and pay rate are correct.
4. Change the Job Task to the correct installation task, e.g. Install System.
5. Enter units as the number of hours spent on the job.
6. Click Add.  
7. Repeat steps for all techs on the job.
Create a Job Appointment
1. [image: ]To schedule a job appointment from SedonaSchedule, click on the Service module.
2. After the service calendar opens, click on Day, Week or Month to change the calendar view.
3. In the toolbar, there are three icons that change the type of appointment being scheduled:
a. The wrench icon is for scheduling service.
b. The hammer icon is for scheduling jobs.
c. The clock icon is for scheduling miscellaneous appointments. 
4. Select the hammer icon.
5. Double click on the calendar on the appropriate day, time and technician slot to begin scheduling the job.
6. Search for and double click on the job you are scheduling.
7. Select the appropriate job task for the installation of the system, often “Install System” or something similar.
8. Choose a time and date for this appointment.
a. You can highlight multiple dates, which will create multiple appointments, but keep in mind that the same start and end times will be used for each date
b. You may also select multiple technicians.
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9. Click Schedule to create the appointment(s).
Complete the Appointment
From Labor/Appointments
1. Go to Labor > Appointments.
2. Right click on the appointment.
3. Choose Edit Appointment.
4. Click Dispatch.
5. Complete each time field: dispatched, arrived, and departed.
6. Click Save.
7. If you have automatic timesheets activated, the timesheet will be created for you after the appointment times are entered. If you are not using automatic timesheets, enter the timesheet in Labor > Timesheets.
From the Service module
1. Open the Service module and navigate to the appointment on the calendar.
2. Click once on the appointment.
3. Click Edit on the grey panel on the left side of the schedule.
4. Complete each time field: dispatched, arrived, and departed.
5. Click Save.
6. If you have automatic timesheets activated, the timesheet will be created for you after the appointment times are entered. If you are not using automatic timesheets, enter the timesheet in Labor > Timesheets.
Tools
[image: ]Purchase Orders
1. [bookmark: _Hlk53918400]Go to Tools > Purchase Orders.
2. Right click anywhere in the white space.
3. Select Create PO.
4. Select a vendor.
5. The purchase order form will open.
6. Parts will automatically load based on information in the materials list. Only parts with this vendor chosen and “Stock” deselected in the Materials list will load on the PO. You can add additional parts manually to the PO.
7. Choose the correct category and order date.
8. Click OK.
Receiving a PO
1. Go to Tools > Purchase Orders.
2. Left click once to highlight the PO to be received.
3. Right click and select Receive PO.
4. Enter the packing slip number in the reference number field.
5. Select the appropriate warehouse.
6. Choose either Receive to Warehouse or Receive & Issue Immediately.
a. It is usually best practice to receive and issue the parts immediately to ensure warehouse stock numbers are not overstated.
b. Avoid using the Direct Expense option unless specifically instructed to do so.
7. Confirm received quantities. Set any parts not received to zero.
8. Click Save.
Issue Parts
1. Go to Tools > Issue Parts.
2. Choose the correct warehouse from the dropdown.
3. Choose the appropriate phase code. If your company is not using phase codes, select Install.
4. Parts not yet issued will automatically populate in the list.
5. Choose an appropriate issue date according to the date parts are being installed or pulled from the warehouse.
6. Adjust quantities as necessary.
7. Click Apply.
Return Parts to Inventory
Option 1: Return from Inventory > Issues/Returns 
1. Expand the Inventory module and click on Issues/Returns.
2. Choose the return type, i.e. Job, Service, or Other.
3. Choose the warehouse to which you will be returning the parts.
4. If you chose a return type of job, enter the job number to correct the part counts in that job.
5. Complete the remaining areas with appropriate information:
a. Phase Code (optional)
b. Memo (optional)
c. Issue Date
d. Category
i. For job returns, choose the appropriate job category.
ii. For service returns, choose the appropriate service category.
iii. For miscellaneous returns, choose a general & administrative category.
e. In Holding & Holding Location (optional)
i. This is typically only used for parts issues, not returns.
6. Check Return to Stock.
7. All parts issued to the job will automatically load at this point.
8. If necessary, change part quantities to reflect which parts you will be removing from the job and returning to stock.
9. You can use the “Set All Qty to 0” button at the bottom of the screen to make this easier.
10. If you are returning all parts on the job, do not change quantities.
11. When the quantities accurately reflect what is going back into the warehouse, click save.
12. This process will create a return in Tools > Issue Parts in the job.
Option 2: Return from inside a job
1. Open the job and go to Tools > Issue Parts.
2. Double click on the original issue in the Previous Issues section to open it.
3. Check Return to Stock at the top of the screen.
4. Part quantities will turn red to indicate they are being returned instead of issued.
5. Edit part quantities to reflect which parts you will be removing from the job and returning to stock.
6. If you are returning all parts in the issue, do not change quantities.
7. If necessary, edit the return date. If the original issue date is in a closed accounting period, you must change the return date.
8. When the quantities accurately reflect what is going back into the warehouse chosen, click Apply.
[bookmark: _Toc53932601]Billing a Job
Once you have approved a task that is flagged for invoicing, you have the option to invoice the job. Each “Y” in the invoice column of the tasks list will create another opportunity to invoice the job until all install, part and recurring charges have been invoiced. SedonaOffice will not allow a user to over-invoice a job.
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Billing Install Charges
1. In the job queue, select the Ready to Invoice button at the top of the screen.
2. Double click on the job you wish to invoice.
3. Deselect Bill RMR.
a. It is usually best practice to bill recurring charges separately from install charges.
4. Change the invoice date and terms if necessary.
5. Change the quantity in the line item according to the percentage to bill.
6. The amount will automatically change to match this quantity.
7. If you would like to charge the customer a flat rate, change the rate rather than the quantity.
8. Enter an appropriate invoice description, e.g. Installation Services.
9. Enter notes for the customer to see in the memo field, e.g. 50% deposit for intrusion installation.
10. Select Add to Print Queue to put the invoice in the print invoices queue.
11. Select Add to Email Queue to put the invoice in the email queue.
12. Click Save.
Billing Recurring Charges
1. In the job queue, select the Ready to Invoice button at the top of the screen.
2. Double click on the job you wish to invoice.
3. Choose an appropriate RMR Reason, such as New-Activation or New-Installation.
4. This is an important step for RMR reporting, so be sure to follow your company’s internal rules for selecting RMR reasons.
5. Enter the Activation Date and the Next Cycle Date. 
a. Typically, the activation date is the central station monitoring start date, and the next cycle date is when the RMR should show up in regular cycle billing.
b. SedonaOffice will automatically adjust the quantity on the line item based on the dates chosen.
Example: RMR prorated for the first month, October, and billed through the end of December. The next cycle date will be January 1st.
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6. Enter an appropriate invoice description, e.g. Installation Services.
7. Enter notes for the customer to see in the memo field, e.g. prorated monitoring services invoice.
8. Select Add to Print Queue to put the invoice in the print invoices queue.
9. Select Add to Email Queue to put the invoice in the email queue.
10. Click Save.
[bookmark: _Toc53932602]Adding a Change Order
When credits referencing the job number are applied to job invoices, charges on that invoice can be rebilled through the job. However, once billed, line items cannot be edited in the job. If line item amounts need to be adjusted, you will have to add a change order to correct the job.
1. To add a change order, first lock the job by approving a task in the Task List that has “sequence locks job” checked.
2. You may want to add a task specifically for this purpose:
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3. Once the new task is approved, the Add Change Order button will appear in Tools.
4. Complete the change order with appropriate information.
a. If you are removing items or reducing amounts, check Manual Reversal.
b. If you are adding items or increasing amounts, do not select Manual Reversal.
5. Click Apply.
1. You can now add or remove materials, commissions, install items and recurring items.
a. When removing an item, make sure to choose the same item that was chosen in the original job. This is the only way the job will recognize that an existing item has been removed.
b. Make sure to use negative quantities in reversal change orders.
2. Go to the Sales Summary in the job to confirm that the totals are correct after you have added the change order.
[bookmark: _Toc53932603]Job Closing Guidelines
[bookmark: _Toc53932604]Review
1. Sales Summary
2. Job Notes
3. Job Costing
[bookmark: _Toc53932605]Closing Date
1. Use the current date.
a. There is usually no need to back-date the closing date because a job accrual can be made to recognize revenue and costs on jobs that are open at month-end (for companies using WIP) or the over/under billing adjustment can be made (for companies not using WIP).
2. EXCEPTION: The closing date may be backdated to a prior month only if all job entries (invoices, parts issuances, tech time entries, commission entries, other costs charged through A/P) were booked in the prior month. It’s common to do this within the first few days after month-end.
[bookmark: _Toc53932606]Reopened Jobs
1. Invoicing and cost entries to reopened jobs should be dated in the same month as the job was originally closed whenever possible to avoid having revenue/costs posted into different months.
2. Close a reopened job using the same date that the job was originally closed.
3. Rather than reopening a job, consider the alternative of creating a new job or service ticket to account for additional work.
4. Make it a standard month-end accounting procedure to review the reopened jobs queue and to close all reopened jobs in accordance with these guidelines.
[bookmark: _Toc53932607]Additional Guidelines
1. Do not close a job if there is any question that it is complete.
2. Always create job credit memos by right-clicking on the job invoice and using the Credit From option on the menu.
[bookmark: _Toc53932608]Service Management
Follow this link to watch instructional videos on the Service Management module:
Service Management Playlist
[bookmark: _Toc53932609]Navigating the Service Interface
To open the Service module, click on Service in the Company File Tree. The Service module will open in a separate window.
[bookmark: _Toc53932610]Calendar
1. Use the calendar at the top left of the service screen to choose a day or multiple days to display in the schedule.
2. Click and drag on the calendar to select multiple days.
3. Dates in bold have appointments scheduled on those days.
[bookmark: _Toc53932611]Detail Tab
1. This tab can be found at the very bottom left of the Service module.
2. Click on an appointment in the schedule or ticket queue to see ticket information in this tab.
a. Site
b. System
c. Contact info
d. Problem
e. Technician
f. Scheduled times
3. Edit
a. Click this button to change or enter:
i. Schedule times
ii. Technician
iii. Resolution
4. Notes
a. Click this button to view any notes that have been entered into this service ticket.
[bookmark: _Toc53932612]Unscheduled Tab
1. This tab can be found at the very bottom left of the Service module.
2. Click this tab to show all tickets that have been created, but not yet scheduled.
3. Double click on a ticket to open it and schedule an appointment.
4. Click the inspections checkbox to show unscheduled inspections.
[bookmark: _Toc53932613]Schedule
Changing a Ticket
1. Drag a ticket between sections to change the technician or the day.
2. Grab the edge of a service ticket and pull up or down to change the appointment time and length.
Using the unassigned technician column    
1. This column shows tickets that have been scheduled but not yet assigned to a specific technician.
2. Use the unassigned technician column to keep track of service tickets when you are not able to assign a technician yet, but the customer needs to get on the schedule.
[bookmark: _Toc53932614]Service Ribbon 
Navigation
Show/Hide the Calendar Bar
Hides or shows the left pane in the display screen.
Today
Displays today’s schedule.
Arrangement
Day/Week/Month
Changes the schedule view to either a day, week or month.
Ticket Queue
Displays a list of open service tickets. Drag headers from side to side to reorder the service ticket info. Drag a header up to the gray bar to group tickets according to certain criteria. Switch to queue view to get a list of service tickets according to selected criteria. This can be chosen by selecting Queue under arrangement and then the Queue tab directly above. Choose the criteria listed according to the tickets you wish to view, including open tickets, tickets with a scheduled appointment, tickets that have not been scheduled, go back tickets, resolved and unresolved tickets, and closed tickets.
Inspection Creation
Begins the process to create inspection tickets. Choose search criteria from the dropdowns on the right side of the ribbon. Choose Get Inspections to populate a list of inspections. Choose the inspection to be scheduled by clicking the checkbox and pressing Create Tickets. The inspection will disappear from this list and move to the Queue, where you can complete the ticket for this inspection as usual.
Note: Inspection records must first be created through the customer record or through a new job.
Removed Parts
Shows all parts removed during service calls within the dates selected in the calendar. Drag along the calendar to highlight desired dates and the removed parts list will automatically populate.
Miscellaneous Appointments
Shows a list of scheduled times on the calendar that can be categorized as holiday, lunch, meeting, sick time, vacation, other or miscellaneous. From the Miscellaneous Appointments tab, you can schedule miscellaneous time for techs or edit existing appointments.
Open Jobs
Displays a list of open jobs.
Batch Billing
Displays a list of resolved service tickets that can be billed. Select the tickets you wish to bill, and click Create Invoices for Selected Tickets.
Sedona Monitor
This section of the ribbon alerts you when the scheduled date for a ticket has passed and no dispatched time has been entered. The Warning Count function easily shows how many of these tickets need attention. Use the dropdown to view these expired tickets.
Calendar Options
Display Groups
This section controls which techs are shown in the schedule. The Display Group Edit button shown below allows you to create groups with only certain technicians. For example, you could create separate groups for techs and installers and assign appropriate employees to each group.
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Show Unassigned
Shows or hides the unassigned technician column in the schedule.
Group Day Within Owner
When selected, the schedule will group first on the technician, and display the date underneath each technician. When deselected, the schedule will group first on the date, and display each technician underneath the date.
Zoom
Changes the number of time slots visible on the schedule. Zooming out shows each hour. Zooming in breaks each hour down to 30- or 15-minute increments.
Tools
Open Customer
When a ticket is selected in the schedule, clicking this button will open the customer record in SedonaOffice.
Refresh Schedule
Looks for any changes in the schedule and updates accordingly.
Ticket Search
Type in a ticket number to open the ticket.
[bookmark: _Toc53932615]Creating a Service Ticket
[bookmark: _Toc53932616]From the customer page
1. Open the customer page
2. Right click on Service in the customer file tree and select New Service Ticket.
[bookmark: _Toc53932617]From the service calendar
1. Click on Service in the Company File Tree.
2. The Service module will open.
3. Find and click on the date you would like to schedule for in the small calendar at the top left of the Service module.
4. Double click in the schedule under the technician’s name at the time you would like to schedule the appointment. Make sure before you double click that the wrench icon is chosen in the service ribbon. 
5. Search for the customer in the lookup screen that opens. The service ticket will then appear.
[bookmark: _Toc53932618]Managing a Service Ticket
[bookmark: _Toc53932619]Setup & Scheduling
1. Fields in bold are required. Write the nature of the service needed in the Comments section.
2. Select Save to make all other buttons in the ticket available.
3. Fill out any custom fields necessary. Custom Fields can be filled with any desired information your company wishes to keep track of through SedonaSetup.
4. If you started the ticket by double clicking on the calendar, the appointment will already be in the Appointments and Labor tab. Double click on the appointment to edit the time or tech. 
5. If you started the ticket from the customer page, click on the Appointments and Labor button, and then click the New Appointment button at the top of the ticket to open the calendar.
6. In the Calendar View, choose the day the appointment needs to be scheduled.
7. Double click on the time of day under the technician to schedule the ticket.
8. SedonaOffice will ask if you are sure this is the day, time and tech you wish to schedule. If so, click Yes
9. The appointment will now appear in the calendar and in the Appointments and Labor tab.
10. Double click on this line to open the dispatch screen.
11. Enter the estimated length in minutes to block the schedule for the correct amount of time.
12. After the service call has been completed, fill in arrival and departure times. If your company charges for or tracks travel, fill in the Dispatched line.
[bookmark: _Toc53932620]Parts
1. Click on the Equipment and Parts tab.
2. All parts in the top section, Customer Equipment Detail, are parts currently held at this site. Click the X under the Removal column to take a part off this list.
3. To add equipment, select New at the bottom of the screen.
4. Search for the part by clicking on the box to the right of the Part field, which will bring up your part lookup screen. You can also type in this field if you know the exact part code. Add a location for future reference, if applicable. All other fields should fill in automatically if correctly entered in the part setup.
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5. Fill in the location area, if pertinent.
6. Check stock to remove the item from inventory.
7. Use the technician dropdown to choose the warehouse from which to remove the parts. This dropdown is controlled by the parts warehouse default in the Service Options tab at the top of your Service module. If left on Warehouse, the dropdown will show all warehouse names. If left on Technician, the dropdown will show all tech names and default to the tech first assigned to the ticket. The part will be removed from the warehouse assigned to that technician in SedonaSetup.
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8. Click Save to add the part to the ticket.
[bookmark: _Toc53932621]Appointments
1. Job appointments and service tickets can be dragged to different days and times from the calendar. Click on the job appointment and pull to another part of the calendar to change the scheduled time or date.
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2. To delete the job appointment, click once on the appointment in the calendar, then click delete on the keyboard.
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[bookmark: _Toc53932622]Clock Out & Clock In
Dispatched and arrival times must be entered into the appointment before the clock in/out options will appear.
1. Right click on the appointment in progress and choose a clock out reason and time on the form provided.
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2. Click Clock Out.
3. This will create a miscellaneous appointment which extends until the end of the original appointment set by the estimated length field.
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4. If an incorrect time was entered, double click on the new miscellaneous appointment to open the edit form. Click the delete button to remove the miscellaneous appointment. Repeat step one above. 
5. Right click on the miscellaneous appointment and complete the clock in form.
6. Click Clock In.
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7. This will create a second appointment for this job or service ticket with a new arrival time. A final departure time should be entered here to complete this appointment.
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[bookmark: _Toc53932623]Print Service Tickets
[bookmark: _Toc53932624]Print One Ticket
1. Open the service ticket.
2. Click on the wrench at the top left of the service ticket.
3. Select Print.
4. Select the correct printer and appropriate options for your service ticket.
5. Click OK to view the ticket before printing.
[bookmark: _Toc53932625]Print Multiple Tickets
1. In the Company File Tree, expand the Service module.
2. Click once on Print Service Tickets.
3. Search for tickets using the available criteria.
4. Click Create List.
5. In the Ticket List tab, check tickets that you wish to print.
6. Select Print.
7. Select appropriate printing options and select OK.
[bookmark: _Toc53932626]Print a Ticket List
From the Ticket Queue
1. Open the Service module and click on the ticket queue. Before printing, make sure your ticket queue is organized.
2. Drag and drop the headers to reorder or click the “funnel” to filter by that header.
3. Click on the Field Chooser at the top left corner of the queue and deselect the headers you do not wish to display.
4. Drag headers into the grey panel above the queue to group by a certain criteria.
5. Choose the search criteria for the queue from the buttons in the ribbon, e.g. open, appointment, go back, etc.
6. Once your queue is organized, click on “Export to Excel.” You can save the document or print at this point.
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From Report Manager
7. Click on Report Manager
8. Click on the Service radio button.
9. Double click the Technician Schedule report. This report will show jobs and service tickets, can be filtered by open or closed, and will show each tech on a separate page.
[bookmark: _Toc53932627]Billing a Service Ticket
1. Open the appointment in the ticket from the Appointments and Labor section.
2. Double click on the appointment.
3. Check Resolves Ticket.
4. Choose an appropriate billable or non-billable resolution.
5. Add text in the Notes field with pertinent information to the work completed.
6. Go to the Billing screen to change billing information. Choose Override Warranty or Override Service Level to change how the customer is being charged.
7. If labor charges are incorrect, check Manual Labor in the Appointments and Labor screen to manually edit labor hours and amounts.
8. Select Create Invoice.
9. The invoice will open outside of the Service module in SedonaOffice.
10. If billing needs to be changed, open the invoice and select the delete data button in the toolbar. Then go back into the service ticket, correct the billing and then select Create Invoice again. This can only be done while the ticket is still open.
11. When all areas of the ticket are complete, click Close Ticket on the first tab of the ticket window.
Note: If the tech needs another appointment to finish the service call, check Put In Go Back Queue instead of Resolves Ticket. You can then add another appointment to the same ticket as many times as needed to complete the service and check Resolves Ticket on the final appointment.
[bookmark: _Toc53932628]Creating and Managing Inspections
All inspections are completed through the Service module. You’ll see the option in the top ribbon to create inspections, but first you’ll want to make sure that your customers have inspections set up on their accounts.
1. Open the customer record.
2. Expand the appropriate system folder.
3. Left click, then right-click on Inspections.
4. Select New Inspection.
5. Fill out the inspection information
6. Required Fields
a. Description
b. Frequency
i. Frequency and Next Inspection date determine when and how often the customer will show up in the inspections area of the service. The next inspection date will be reset based on the frequency each time a ticket is created. The “ByRequestOnly” frequency will not automatically pull the inspection item into service, though all other frequencies will. If you use By Request Only, you must come back to the inspection item and reset the frequency before creating the ticket. 
c. Service Problem Code
i. Most companies create an inspection problem code for this purpose.
d. Service Level
i. Most companies create service levels called Inspection – T&M and Inspection – Contract so these tickets will bill correctly by default.
e. Service Company
i. The service company controls the default category, COGS account, and labor setup. If any of these settings are different for inspections than for regular service, make sure to create an inspection company in SedonaSetup/Service Companies. 
f. Next Inspection Date
i. Set the date you want this inspection to appear in the Service module. This date will always be based off the original next inspection date plus the frequency. If you create an inspection appointment with a date that is not close to the next inspection date, you will have to go into the inspection item and change it so that it is correct next time. 
g. Estimated Hours
7. Optional Fields
a. Charges 
i. This area will add the invoice item chosen to the “Other Items” tab of the service ticket. This area can be used to add any charge necessary to the ticket. Many companies use this to charge the recurring item rather than allowing the RMR item to cycle separately from the ticket. 
b. Service Tech
i. You can assign a service tech to populate each time this inspection ticket is created. If this varies, leave this field blank. 
c. Last Inspection
d. Notes
Note: You can save an inspection without completing the Next Inspection field, but the inspection will not be available for creation from the Service module. You must return to the customer and enter this date to schedule the ticket.
8. Open SedonaSchedule.
9. Select the Inspection Creation button in the ribbon.
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10. Choose a Due As Of date and any other desired information from the dropdowns in the ribbon to search for the inspection.
11. Click Get Inspections.
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12. Select your inspection by clicking inside the checkbox on the left.
13. Click Create Tickets in the ribbon.
14. The inspection will disappear from this list and move into the ticket queue. From the open items screen in the customer explorer, you can see that this customer now has an open service ticket on their account. Open the ticket from this page or search for the ticket in the ticket queue by changing the search criteria from service tickets to inspections. You can also find the ticket in the unscheduled tickets tab.
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[bookmark: _Toc53932629]Purchase Orders & Inventory
Follow this link to watch instructional videos on the Accounts Payable and Inventory modules:
Purchase Orders & Inventory Playlist
[bookmark: _Toc53932630]Creating a Purchase Order
At the top of the purchase orders list, choose all vendors and then New to choose a vendor from within the PO. Choose a specific vendor at the top of the purchase order list to automatically create a PO for that vendor.
1. Open the Purchase Orders function in the Accounts Payable module.
2. Select New.
3. Choose a vendor, category and warehouse from the dropdowns at the top of the PO.
4. Order Date will default to today’s date. Change if necessary.
5. Enter Ship Date, Method and Parts Due Date if this information is known.
6. Apply this PO to a job only if all parts in this PO are being used for this job.
7. Use the ellipsis button to select and add parts:
[image: ]
8. Click OK.
[bookmark: _Toc53932631]Receiving Parts
If this receipt has a purchase order already entered in SedonaOffice, right click on the PO from the vendor’s page and select Receive Purchase Order so that the receipt will automatically populate with the parts from the PO or follow the instructions below.
1. From the vendor record, right click on Receipts.
2. Select New Receipts.
3. SedonaOffice will ask if you would like to choose from an existing list of POs or returns.
4. Select Yes.
5. Double click on the PO or repair order you are receiving.
6. All parts and information will automatically load.
7. Receive Date will default to the current date. Change if necessary.
8. Change amounts in the expense tab if charges are different in SedonaOffice than on the receipt from the vendor.
9. Click Save.
10. To create a partial receipt, simple edit the quantity column for each part. If you only want to receive one part on that PO, change the quantity of all OTHER parts on the receipt to 0. Or if a partial amount of the parts came in, such as 10 out of 20, change the quantity to reflect what came in. The PO will recognize these changes and stay open until all parts are received. Some users prefer to delete lines rather than to zero them out. If that's you, highlight the line by clicking on the grey box to the left of the part code. The entire line will turn blue. Then click the delete button on your keyboard.
[bookmark: _Toc53932632]Returning Parts to Stock
1. Expand the Inventory menu and click on Issues/Returns.
2. Choose the return type ‘Other’.
3. Choose the warehouse to which you will be returning the parts.
4. Complete the remaining areas with appropriate information.
a. Reference (optional)
b. Issue Date
c. Category 
d. Cost of Goods Sold GL account
5. Check Return to Stock.
6. Type or search for part numbers in the part section and enter the correct quantities. 
7. When part quantities accurately reflect warehouse quantities, click save.
[bookmark: _Toc53932633]Breaking Out a Kit
1. Open the Parts function in the Inventory module.
2. Double click on the kit.
3. In the part’s page, open the Warehouses function.
4. Right click on the appropriate warehouse.
5. Select Break Out Kit.
6. Choose the warehouse, date and quantity to break out.
7. Click Save.
Note: The basic vendor information snapshot in the top section of the explorer will now show that the on-hand amount of the kit has decreased by one.
[bookmark: _Toc53932634]Processing Return/Repair Orders
[bookmark: _Toc53932635]Repair Orders
1. Click on the Repair Orders function in the Inventory module.
2. Choose a vendor.
3. Select New.
4. Enter category and warehouse.
5. If needed, enter a Due Date.
6. Use the ellipsis button to select a part to be repaired.
7. Use the arrow button under the Expenses tab to add miscellaneous expenses related to the repair order.
8. Enter a memo to appear on the repair order if necessary.
9. Print the repair order using the print preview button in the toolbar.
10. Click Save.
[bookmark: _Toc53932636]Return Orders
1. Click on the Return to Vendor function under the Inventory module.
2. Choose a vendor, reference number and memo (optional).
3. Select a part to return and complete the form.
4. Click Save.
5. Re-open the return order from the vendor’s page.
6. Open the Accounts Payable module, then the Vendors function.
7. Double click on the vendor to open the vendor’s explorer.
8. Click on Returns in the file tree.
9. Double click on the return order to open it.
10. You now have the option to create a vendor credit from this return order.
11. Select Save to automatically open the vendor credit.
[bookmark: _Toc53932637]Completing a Warehouse Transfer
1. Go to Inventory/Transfers
2. Click “New” at the bottom to start the transfer form
a. You must enter a request date, but the in process date and shipped date are designed for transfers between branches. These dates can be left blank if you are transferring between a warehouse and a truck, or the dates do not apply for any reason. 
b. If you choose to enter dates here, the status will be updated to match the date field you have entered. For example, when you enter the in process date, the status will change to “In Process.” When you enter the shipped date, the status will change to “Shipped.” You should leave the transfer open, updating these date fields as necessary until the second branch can receive and close the transfer. 
3. For Job/Service
a. You may reference a job or service ticket number, but this field is informational only and will not affect the job or ticket. 
4. Manual Transfer
a. Choose this option to build your own list of parts to transfer. 
b. Search for a part code and enter the transfer quantity at the bottom of the transfer request form.
c. Click Add after typing each part code. Do this for each part that you wish to transfer until the list of parts is complete.
5. Min/Max Transfer
a. Choose either option to transfer a predetermined list of parts and quantities. This is based on the minimum or maximum quantities you have saved for each warehouse in the part code setup. This is especially useful when transferring to trucks on a regular basis because it will prevent you from having to build the transfer list from scratch each time. 
6. Save
a. Before saving the list, take note of parts in red. These parts do not have a high enough quantity in the source warehouse to complete the transfer. You can save the transfer with these parts, but they must be in stock or removed before the transfer can be completed. 
b. Once you click save, the transfer will be saved in the Transfer Requests area. You must click “Receive” to complete the parts transfer. 
c. You may go back into any transfer after saving and delete it before receiving if necessary. 
7. Save/Receive
a. Click this option to immediately complete the transfer.
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8. Receive Transfer Request
a. Review the parts in this list before completing. If any parts have a higher requested quantity than source quantity, you will not be able to save. Change the amounts in the Received Quantity column to move on. 
b. Choose the date of transfer. 
c. Click Save to close the transfer and move parts between warehouses.
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[bookmark: _Toc53932638]Entering a Stock Adjustment
9. Open Inventory/Parts from the company tree
10. Search for the part and double click on it to open the part page
11. Right click on the warehouse name
12. Click Stock Adjustment
13. Complete the adjustment form
a. Adjustment Date: typically this date should be set to the current date. 
i. Stock adjustments from the part page will adjust inventory to the amount entered in the New Quantity field as of the current date, regardless of the date you place in the Adjustment Date field. Backdating the adjustment date will only create whichever entry is necessary on that date for SedonaOffice to reach the New Quantity as of the current date.
ii. For example, part BK-2WB KIT had a quantity of 10 as of 12/1/2015. 10 more were added to stock on 2/17/16 for an on hand quantity of 20:
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iii. Then a stock adjustment was performed and backdated to 2/3/16:

[image: ]

iv. The adjustment is added to the journal as of 2/3, but the on hand quantity is changed to 15 as of the current date. That means a -5 adjustment is made to account for the current on hand quantity of 15.
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b. New Quantity: correct quantity as of today.
c. Value: this field will auto-calculate based on the current standard cost for the warehouse being adjusted. Correct standard cost before making this adjustment if necessary.
d. Account Code: for most companies, this will default to 580112 COS – Parts O/H (Count Variance). This can be changed to any COGS account.
e. Category Code: chosen according to company accounting rules.
f. Memo: optional
[bookmark: _Toc53932639]Using the Suggested PO List
1. Click on the Suggested PO List in the Accounts Payable module.
2. From the dropdowns, choose a vendor, warehouse, and product if desired.
3. Click the Bring to Minimum or Bring to Maximum radio button (Min and Max amounts are determined in part setup).
4. Click the green arrow to find all parts within the criteria.
5. Click Create PO at the bottom to start a PO for these parts.
a. You must choose a single vendor to see the Create PO option.
[bookmark: _Toc53932640]Accounts Payable
Follow this link to watch instructional videos on the Accounts Payable module:
Accounts Payable Playlist
[bookmark: _Toc53932641]Entering Vendor Bills
[bookmark: _Toc53932642]Create a Vendor Bill
1. Click on Bills under Accounts Payable in the company file tree.
2. Choose a vendor from the dropdown at the top left corner.
3. If this vendor has any open PO receipts, you will be prompted to choose one. Click Yes and double click on the correct receipt if this bill has a corresponding PO and receipt. Click No if you are starting a bill without a corresponding receipt.
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4. Enter a reference number, typically matching the vendor invoice number.
5. Enter all other known information and update costs on parts, if necessary.


Note: if costs on parts are changed, the Amount field also needs to be manually updated. When costs are changed on the bill, the vendor cost on the part setup page will be changed as well after you click Apply. Changes in part costs using this method do not update standard cost. Contact support@astutefinancial.biz if you need to update standard costs to reflect changes in part costs from bills.
6. If the bill is using a parts receipt, parts will load automatically. If the bill does not have a receipt, individual parts cannot be entered onto the bill. The expense tab must be used.
7. Add expenses to the Expense tab in the bill. Update the amount field at the top of the bill to match the total shown at the bottom.
8. For expenses not related to jobs, use indirect cost of goods sold accounts in the expense tab to create the bill. Several accounts can be used to break the bill into multiple amounts.
9. Use the costing search box to enter a job number the bill. This will enter all parts and expenses from this bill onto the chosen job.
10. If the bill has expenses, but no parts, you can enter the job number in the job costing area of each expense line. Each expense can be designated to a different job. If this method is used to show costs on multiple jobs, do not enter a job number into the search box above. That area is used to apply an entire bill to one job. 
11. When job numbers are entered onto the bill, make sure to choose a type of ‘WIP’ (Work In Progress). Other expenses can be given a type of ‘Other.’
12. For expenses related to jobs, use direct job cost of goods sold accounts.
13. Select the Recurring Bill checkbox in the top right corner of the bill to put this bill into the Recurring Items function. You can later change the frequency and future due dates from the Recurring Items function.
[bookmark: _Toc53932643]Creating and Applying a Vendor Credit
[bookmark: _Toc53932644]Create a Vendor Credit
If the credit was given because of a parts return, open the return from the vendor page and check Create Vendor Credit to automatically create a return related to those parts. If there is no parts return, follow the instructions below.
Expenses
1. Open the vendor page.
2. Right click on Credits and select New Credit.
3. Choose a category.
4. Enter pertinent information from the vendor in the Reference # field.
5. Choose a Branch, amount of credit, and date.
6. In the Costing field, use the binoculars to search for a job if the credit is related to a job.
7. If necessary, change the GL Account.
8. Enter an amount to credit.
Parts
1. Parts will be loaded automatically in this tab if the credit is created from a parts return.
[bookmark: _Toc53932645]Apply a Vendor Credit
1. Open the Pay Bills function.
2. Search by Branch, Vendor and Due Date to pull up a list of vendor bills.
3. In the Vendor Bills tab, select the bills being paid.
4. In the Vendor Credits tab, select the credits to be applied.
5. Credits will automatically subtract from the total amount, which will show at the bottom of the screen.
6. Click Save.                 
Note: To apply a credit from the vendor’s page, right click on the credit and select Apply Credits. The Pay Bills function will automatically open and the above instructions can then be followed.
[bookmark: _Toc53932646]Paying Vendor Bills
1. Open the Pay Bills function under Accounts Payable.
2. Selection Information Section:
a. Filter the list by choosing Branch, Vendor and As of Due Date. This criteria will control which bills load into the screen. You must choose one vendor at a time to pay with a credit card. 
b. Click the checkboxes for the bills you want to pay or type in the amount under the Paid column on the right.
3. Payment Information Section:
a. Choose Branch and Payment Date.
b. Choose to pay with a bank account or credit card.
i. Choosing bank account will send the payment to the Print Checks function where you can then print and send a check. Choosing credit card will credit off the original vendor bill and create a bill on the credit card’s vendor account. 
4. Go to the Vendor Credits tab and select the checkboxes to apply credits to a bill.
[bookmark: _Toc53932647]Printing Checks
1. Open the Print Checks function.
2. Choose which bank account is paying the check.
3. Select which checks will be printed or choose Select All.
4. Margins:
a. Use the arrows to move the text to line up appropriately on the check.
b. Push Test to preview the page and print.
c. Apply to save the margins of the check.
5. Click Print Bill List to preview and print a list of bills by vendor with credits, discounts and cash applied.
6. Select Print to open a print preview of the checks to be printed.
a. After closing the print preview, Sedona will ask if you wish to mark these checks as printed. Select Yes to remove these checks from the Print Checks function. You will then have the option to print remittances.
[bookmark: _Toc53932648]Entering a Manual Check
1. Open the Write Checks function.
2. Search for a customer or vendor (address will automatically populate).
3. Enter a check number, amount and memo. 
4. If there is no check number, enter a reference such as “auto draft” or “eft”.
5. Check In Print Queue to print this check later from the Print Checks function.
a. Select Print at the bottom of the screen to print this single check immediately.
6. Select Recurring Payment to put this check into the Recurring Items function.
7. Use the binoculars next to the Costing field to link this check to a job.
8. Select a GL Account, description, amount, branch, and category.
9. Click Save.
Note: If you check the Recurring Payment checkbox, after you save the check, another form will come up requiring recurring payment information. Enter the frequency and correct dates for the check.
[bookmark: _Toc53932649]Create A/P Recurring Items
Checks and Bills must be designated as recurring items through Write Checks or Bills before they will appear in the Recurring Items function.
1. Click on the Recurring Items function.
2. Choose the recurring item from either Checks or Bills.
3. Double click or select Create to make the next scheduled entry.
4. Click Save to print individually or send to the Print Checks function.
Note: Items in red are past due. Print items to turn them black.
[bookmark: _Toc53932650]SedonaOffice Add-Ons
[bookmark: _Toc53932651]Managing Bridgestone Reports
[bookmark: _Toc53932652]Report Types
Bridgestone creates reports each time invoices are sent which give details about invoice delivery. Contact your Bridgestone representative to access these reports.
1. invdropd: details of undeliverable/dropped invoices
2. nffwd: invoices for sites with a National Change of Address request
3. cd1rejs: code one reject addresses for which Bridgestone cannot produce a barcode
4. trackng: list of all invoices received on the given date
Note: NFFWD and Cd1Rejs reports may show address discrepancies, but this does not necessarily mean that those invoices have been dropped. The invdropd report is the only report that lists which invoices have been dropped.
[bookmark: _Toc53932653]Reading the Reports 
Tracking Report
1. The tracking report will show basic information about the invoices sent in each export, including each invoice number, a Y or N indicating if the invoice was mailed or not, and a total number of mailed and dropped invoices.
Example:
[image: ]
Dropped Invoice Report
1. A dropped invoice means it is undeliverable by USPS, typically due to incorrect address. The exception to this is when an invoice has a $0 balance due, which BFIS automatically drops. The most important parts of the dropped report are the invoice number, the drop reason, and the total number of invoices dropped.
Example: 
[image: ]
2. Use the drop reason to determine if there is a problem with the address entered into SedonaOffice or if the invoice was dropped for outside reasons.
Code 1 Reject Report
1. If an address is in the reject report, it does not mean that the invoice did not get mailed. These addresses do not exactly match with USPS but are still deliverable.
2. In the example below, you can see that the address has an unmatched house number. This invoice may have been deliverable because the mail carrier knows the area very well. However, a future mail carrier may not be able to deliver this invoice, so it is a good idea to attempt to match these addresses with USPS, but it is not absolutely necessary.
Example: 
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NFFWD Report
1. This report shows invoices that have been sent to an address with a National Change of Address request filed with the USPS and are being forwarded.
[bookmark: _Toc53932654]Fixing a Billing Address
1. Once you discover the reason the invoice was dropped, go to USPS.com and use the lookup tool to determine the correct address.
2. Edit the address in the billing record on the account. 
3. Once you have corrected the billing addresses in SedonaOffice, you can then open the appropriate invoice, change the bill to (upper left button), and then add the invoice to the print queue again.
4. If the address appears to be correct, you may have formatting issues on the customer’s SedonaOffice page, so check that all address info is entered in the appropriate labels on the bill to.
Note: If you have completed all steps and still cannot determine why the address isn’t valid, you will need to contact the dealer or customer. If the customer confirms that the address is correct, contact Bridgestone to put a bypass on the address, so that it will be mailed despite the discrepancy.


[bookmark: _EFT_Response_Codes][bookmark: _Toc53932655]EFT Response Codes
A01 (credit cards) and S01 (banks) are the only two codes indicating a successful transaction. All other codes indicate a declined transaction.
	Code
	Name
	Description

	A01
	Funded
	Funded

	F01
	Mandatory Field Missing
	Mandatory Required Fields missing from the file

	R01
	Insufficient Funds
	Balance is not sufficient to cover value of transaction

	R02
	Account Closed
	Previously Open Account has been closed

	R03
	No Account
	Account is closed or doesn't match name submitted

	R04
	Invalid Account Number
	Account Number structure is invalid

	R05
	Prenote Not Received
	Prenotification was not received

	R06
	Returned per ODFI
	ODFI has requested RDFI to return this item

	R07
	Authorization revoked
	Account holder has revoked company's authorization

	R08
	Payment Stopped
	Account holder has stopped payment on this single transaction

	R09
	Uncollectable Funds
	Balance is sufficient but can't be released

	R10
	No Authorization
	Account holder advised that transaction is not authorized

	R11
	Check Safekeeping Return
	Return of a check safekeeping entry return

	R12
	Branch Sold
	Account now at a branch sold to another financial institution

	R13
	RDFI Not Qualified
	RDFI Not qualified to participate

	R14
	Deceased
	This account holder is deceased

	R15
	Beneficiary Deceased
	Beneficiary entitled to benefits is deceased

	R16
	Account Frozen
	Funds unavailable due to action by RDFI or other legal action

	R17
	Field Record Criteria
	Field Record/Edit Criteria

	R20
	Non Transaction Account
	Policies/Regulations restrict activity to this account

	R23
	Payment Refused
	Account holder refuses transaction because amount is inaccurate or other legal

	R24
	Duplicate Entry
	Transaction Appears to be a duplicate item

	R26
	Mandatory Error
	Transaction is missing data from a mandatory field

	R28
	Invalid TRN
	Transit Routing Number is Invalid

	R29
	Corporate Not Authorized
	Corporate Receiver has notified RDFI that Corp entry is not authorized

	R31
	ODFI Permits Late Return
	ODFI Agrees to accept a return

	R50
	Invalid Company Id
	The Owner Company Id is NOT valid

	R56
	Invalid Transaction Date
	Date specified is Invalid

	R57
	Stale Date
	Transaction is too old for processing

	R95
	Over Limit
	This transaction is over your authorized limit

	R96
	Account on Hold
	This company account is on hold

	R97
	RDFI Does Not Participate
	RDFI does not allow this type of transaction

	R98
	Invalid Password
	The password supplied was invalid

	R99
	Declined Unpaid Items
	The account or ID has been declined due to unpaid items

	S01
	Funded
	Funded

	U01
	Merch Auth Revoked
	Merchant not allowed to access customer account

	U02
	Account Not Approved
	Customer Account is in the ACH DIRECT known BAD LIST

	U03
	Daily Trans Limit
	Merchant Daily Limit Exceeded

	U04
	Monthly Trans Limit
	Merchant Monthly Limit Exceeded

	U05
	AVS Failure Zip Code
	AVS state/zip code check failed

	U06
	AVS Failure Area Code
	AVS state/area code check failed

	U07
	AVS Failure Email
	AVS Anonymous email check failed

	U08
	Daily Velocity
	Account has more transactions then the daily velocity limit

	U09
	Velocity Window
	Account has more transactions then the velocity window allows

	U10
	Duplicate Transaction
	Transaction has the same attributes as another transaction

	U11
	Recur Trans Not Found
	Recurring Transaction not found

	U12
	Bad Status for Update
	Original Transaction not Voidable

	U13
	Orig Trans Not Found
	Transaction to be voided not found

	U14
	Bad Type of Orig Trans
	Void/Capture and Original Transaction do not agree

	U18
	Update Failed
	Void or Capture failed

	U19
	Invalid TRN
	Account ABA Number is invalid

	U20
	Invalid Credit Card Numb
	Credit Card Number is Invalid

	U21
	Bad Start Date
	Bad Start Date

	U22
	Swipe Data Failure
	Swipe Data is malformed

	U23
	Invalid Expiration Date
	Malformed Expiration Date

	U51
	Merchant Status
	Merchant is not live

	U52
	Type Not Allowed
	Merchant not approved for transaction type

	U53
	Per Trans Limit
	Transaction amount exceeds merchants per transaction limit

	U54
	Invalid Merchant Config
	Merchants configuration requires updating - call customer support

	U80
	PreAuth Decline
	Transaction was declined due to preauthorization

	U83
	Auth Decline
	Transaction was declined due to authorizer declination

	U84
	PreAuth Timeout
	PreAuthorization not responding

	U85
	PreAuth Error
	PreAuthorization Error

	U86
	AVS Failure Auth
	Authorized AVS
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